AppleCD 300i Plus
User's Guide
Contents

Communications regulation information vi

Preface Correct Versions of CD-ROM and QuickTime Software ix

1 Setting Up and Using Your CD-ROM Drive 1

Types of compact discs you can use 2

- Standard file formats 2
- Other CD-ROM formats 2
- Audio CDs 3
- Photo CDs 3

Is your CD-ROM software already installed? 3

Inserting and ejecting discs 4

- Inserting a disc 4
- Ejecting a disc 5

Care and handling 6

Sharing a CD-ROM disc over a network 8
2  Playing Audio Compact Discs and Audio Tracks on CD-ROM Discs  9

Starting up your audio CD software  10
Using the AppleCD Audio Player  11
  Basic controls  12
  Additional controls  14
  Creating your own order for playing tracks  17
  Another way to start audio tracks  18
  To close or quit the AppleCD Audio Player  19
Using CD Remote  19
  Basic controls  20
  Additional controls  22
  Creating your own order for playing tracks  24
  To close or quit CD Remote  26

3  Working With Photo CD Images  27

Obtaining Photo CDs  28
Using Photo CDs  28
Before viewing the contents of a Photo CD  29
Viewing the contents of a Photo CD  30
Viewing several images in sequence  34
Setting preferences for how Photo CD images are displayed  35
  A note about resolution  37
Working with Photo CD images in other programs  37
  Transferring the displayed image to another program  38
  Copying images from a Slide Show movie  39
  Copying a Slide Show movie onto another disk  40
4 Reinstalling CD-ROM Software 41

Reinstalling CD-ROM software from a CD 42
  Reinstalling all the software 42
  Reinstalling only specific parts of the software 44
Reinstalling CD-ROM software from a floppy disk 46
  Reinstalling all the software 46
  Reinstalling only specific parts of the software 47

Do you have a Performa computer? 49

About the QuickTime extension 50
  Seeing if QuickTime is installed 50
  Seeing if you have the correct version of QuickTime 50
  Determining how you should install QuickTime 50
  Installing QuickTime from a CD 51
  Installing QuickTime from a floppy disk 52

5 Troubleshooting 53

Problems starting up your computer 54
Problems using CD-ROM discs 55
Problems using ISO 9660 or High Sierra discs 56
Problems playing audio CDs 57
Problems using Photo CDs 58

Appendix Specifications 61
Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct the interference by using one or more of the following measures:

- Turn the television or radio antenna until the interference stops.
- Move the computer to one side or the other of the television or radio.
- Move the computer farther away from the television or radio.
- Plug the computer into an outlet that is on a different circuit from the television or radio.
  (That is, make certain the computer and the television or radio are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. You may find the following booklet helpful: Interference Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal Communications Commission, is available from the U.S. Government Printing Office, Washington, DC 20402.

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc., could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices and Apple shielded cables and connectors between system components. It is important that you use Apple peripheral devices and shielded cables and connectors between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices, contact the manufacturer or dealer for assistance.
**DOC statement**

*DOC Class B Compliance*  This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

*Observation des normes—Classe B*  Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur : “Appareils Numériques,” NMB-003 édictée par le ministre des Communications.

**CD-ROM drive**

**WARNING**  Making adjustments or performing procedures other than those specified in your equipment’s manual may result in hazardous exposure.

**WARNING**  Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.

Your computer is a Class 1 laser product. The Class 1 label, located on the CD-ROM drive, indicates that the CD-ROM drive meets minimum safety requirements.

![Class 1 label](image)
Correct Versions of CD-ROM and QuickTime Software

This preface explains which versions of CD-ROM and QuickTime software are needed for you to use your new AppleCD 300i Plus CD-ROM drive.

Which version of Macintosh system software do you have?

Check to see which version of system software is installed on your computer.

- On your screen, click the desktop. Then pull down the Apple () menu and choose About This Macintosh.

A window appears, displaying your system software version number.

If you have system software version 7.1.1 or earlier

If the system software version on your computer is 7.1.1 or earlier, the correct versions of CD-ROM and QuickTime software came on disks provided with your AppleCD 300i Plus CD-ROM drive. Your service provider may have already used the disks to install your software. (If you're not sure, see “Is Your CD-ROM Software Already Installed?” in Chapter 1 of this manual.) If you need to install the software yourself—or reinstall it later—see “Reinstalling CD-ROM Software From a Floppy Disk” and “About the QuickTime Extension” in Chapter 4.
If you have system software version 7.1.2 or later

If the system software version on your computer is 7.1.2 or later, the correct versions of CD-ROM and QuickTime software were installed with your original system software. Neither you nor the service provider needs to install CD-ROM or QuickTime software.

IMPORTANT If you have system software 7.1.2, do not install CD-ROM and QuickTime software from the floppy disks provided with the AppleCD 300i Plus CD-ROM drive.

If you ever need to reinstall either the CD-ROM or the QuickTime software, follow the instructions for reinstalling system software in the user's guide that came with your computer. Use the Custom Installation option to install just the software components that you need. (The correct versions of software are on floppy disks, or on a CD-ROM disc, that came with your computer.)
Setting Up and Using Your CD-ROM Drive

Your internal CD-ROM (Compact Disc Read-Only Memory) drive for Macintosh computers works with CD-ROM discs, standard audio compact discs (CDs), and single-session or multisession Photo CDs. Your CD-ROM drive provides access to large amounts of information. However, you cannot save information on CD-ROM discs. ROM stands for “read-only memory,” meaning that the drive cannot “write” information onto CD-ROM discs.

A wide selection of CD-ROM discs is available for entertainment, education, and business. A typical disc can hold over 650 megabytes (MB) of information—the equivalent of 270,000 pages of text, up to eight hours of speech or music (depending on the sound quality), hundreds of high-resolution images, or any combination of text, sound, and graphics.
Types of compact discs you can use

Not all CD-ROM discs store information in the same way. A disc stores and displays information according to a given file format. Your computer's system software must understand the file format in order to use the contents of the disc.

Standard file formats

You can use CD-ROM discs with these standard file formats:

- HFS (Hierarchical File System)—the standard format used by the Macintosh.
- ISO 9660—the International Standards Organization's file format for CD-ROM discs. This format has been adopted by many CD manufacturers to make their discs compatible with a variety of computers. It is also the format that allows you to use Photo CDs in your CD-ROM drive.
- The High Sierra format, a predecessor of the ISO 9660 format.

Software that lets you use discs with these file formats is probably already installed on your computer. To check whether the software is installed, see “Is Your CD-ROM Software Already Installed?” later in this chapter.

Other CD-ROM formats

Your CD-ROM drive also works with file formats other than the ones listed above (for example, CD-ROM XA), provided that you install the appropriate software on your Macintosh. See the Appendix for more detailed information on formats, or modes, supported by your CD-ROM drive. To find out about the availability of Macintosh software for additional file formats, contact the publisher of a particular disc.
Audio CDs

Your CD-ROM drive can play audio CDs and audio tracks on CD-ROM discs using your computer’s built-in speaker. You can also attach headphones or speakers to your computer for stereo sound. For further information, see Chapter 2, “Playing Audio Compact Discs and Audio Tracks on CD-ROM Discs.”

Photo CDs

With your CD-ROM drive, you can open digitized images stored on Photo CDs. To view Photo CD images, you must have QuickTime 1.6.1 or later and Apple Photo Access installed in your System Folder. In most cases, QuickTime and Apple Photo Access are already installed. If you need to reinstall QuickTime, see “About the QuickTime Extension” in Chapter 4. If you need to reinstall Apple Photo Access, follow the instructions for reinstalling CD-ROM software in Chapter 4.

For further information on Photo CDs, see Chapter 3, “Working With Photo CD Images.”

Is your CD-ROM software already installed?

In most cases, all the software required for using your CD-ROM drive is already installed on your computer and is ready to use.

To check whether CD-ROM software is already installed, pull down the Apple (‡) menu.

If either AppleCD Audio Player or CD Remote appears in the menu, then the CD-ROM software has already been installed.

If neither AppleCD Audio Player nor CD Remote appears in the menu, you must reinstall the CD-ROM software.
Follow the instructions in the appropriate section in Chapter 4 of this manual.

- If you have a Performa computer, see “Do You Have a Performa Computer?”
- If your computer came with an internal CD-ROM drive, you also received an accessory kit that includes a CD containing your system software. See “Reinstalling CD-ROM Software From a CD.”
- If you originally purchased your computer without an internal CD-ROM drive and later upgraded to add this CD-ROM drive to your system, your CD-ROM software is on a floppy disk. See “Reinstalling CD-ROM Software From a Floppy Disk.”

**Inserting and ejecting discs**

Your CD-ROM drive uses a tray to hold a CD-ROM disc in place while a laser reads information from the disc.

**Inserting a disc**

Follow these instructions to insert a CD-ROM disc into your CD-ROM drive.

1. **Start up your Macintosh computer, if it's not already on.**
2. **Press the Open/Close button to open the tray of the CD-ROM drive.**

The tray opens.
3 Place a CD-ROM disc in the tray, with the disc label facing up.  
Make sure the disc is lying flat in the tray.

4 Push the tray in, or press the Open/Close button, to close the tray.

In a few moments, an icon for the CD-ROM disc appears on your screen.  

**Ejecting a disc**

Follow these instructions to open the tray and eject a CD-ROM disc from your computer.

**IMPORTANT** You cannot eject a disc if it is being shared. To turn off file sharing, see the manuals or on-screen help that came with your computer.

1 Open the tray.

There are several ways to open the tray of your CD-ROM drive.

*If a CD-ROM disc icon appears on your screen:*

- Select the disc icon on your screen and drag the icon to the Trash.
- Click on the disc icon, then choose the Put Away command in the File menu.
- While the AppleCD Audio Player window is active, choose Eject CD from the File menu, or simultaneously press the ⌘ and E keys.
If no CD-ROM disc icon appears on your screen:

- Press the Open/Close button for your CD-ROM drive.

**IMPORTANT** If you have any difficulties opening the tray, see “Problems Using CD-ROM Discs” in Chapter 5.

2  Take the CD-ROM disc out of the tray.

Store your disc in a safe place, away from heat, dust, and moisture.

3  Push the tray in, or press the Open/Close button, to close the tray.

To avoid possible damage to the tray or the CD-ROM drive, keep the tray closed when you are not using it.

The tray on your CD-ROM drive automatically closes when you shut down your computer. You may want to open the tray and take out your CD-ROM disc before shutting down.

**Care and handling**

Keep these important safety instructions in mind as you use your CD-ROM drive.

- Position your computer so that when the tray opens, it doesn't bump into anything.
- Do not leave the disc tray open. If dust gets on the lens of the CD-ROM drive, the drive may have problems reading your compact discs.
- Do not put anything (for instance, a cup) on top of the tray when it is open.
- Do not force the tray open by hand.
- Do not wipe the lens with a paper towel or other abrasive surface. If you need to clean the lens, see an Apple-authorized service provider for a lens cleaner.
- Never transport your computer with a disc inside the CD-ROM drive.
- Keep your computer equipment away from any source of liquid (such as wash basins, bathtubs, and shower stalls). If you drink coffee or other beverages while you're at your computer, take care not to spill.
Avoid exposing your equipment to damp or wet weather. If your system is near a window, be sure the window is closed in rainy weather.

**WARNING** Electrical equipment may be hazardous if misused. Operation of this product or similar products must always be supervised by an adult. Do not allow children access to the interior of any electrical product and do not permit them to handle cables.

Keep these important safety instructions in mind as you use CD-ROM discs:

- Hold a disc by the edges or by one edge and the center hole. Do not touch the disc surface.
- To clean discs, wipe the shiny surface with a soft damp cloth, working in straight lines from center to edge. Do not use any form of cleaning agent.
- To avoid damage to your discs, keep these points in mind:

  - Do not expose discs to direct sunlight.
  - Do not spill liquids on discs.
  - Do not scratch discs.
  - Do not write on discs.
  - Do not put tape on discs.
  - Do not get dust on discs.

- Keep these instructions handy for reference.
- Follow all instructions and warnings dealing with your system.
Sharing a CD-ROM disc over a network

You can share a CD-ROM disc using the file-sharing feature of System 7. If the disc has audio portions, you will be able to hear the audio yourself, but other people on the network will not. Likewise, you cannot hear the audio portions of discs you access over a network.

For further information about file sharing in System 7, see the manuals or on-screen help that came with your computer.
With your CD-ROM drive and your computer's built-in speaker, you can play audio compact discs (CDs) or audio tracks on CD-ROM discs. You can also attach headphones or speakers to the computer to listen to audio CDs and audio tracks. See the manuals that came with your computer or sound devices for information on connecting the devices to your computer.

You use specific audio CD software to start, stop, and otherwise control audio discs. Your CD-ROM drive came with one of the following audio CD application programs:

- AppleCD Audio Player
- CD Remote

Before you use this audio CD software, make sure that the compact disc you are playing contains audio information. Your audio CD software will only play tracks that contain audio information. You can listen to an audio CD or audio tracks in the background while you do other work on your computer.
Starting up your audio CD software

The following instructions apply to both the AppleCD Audio Player and the CD Remote program. After starting up your audio CD software, continue with the section that explains how to use the audio CD software you have on your computer.

1. Start up your Macintosh computer, if it's not already on.

2. Press the Open/Close button to open the tray of the CD-ROM drive.

3. Place the audio CD (or the CD-ROM disc with audio tracks) in the tray, with the disc label facing up.

   Make sure the disc is lying flat in the tray.

4. Push the tray in, or press the Open/Close button, to close the tray.

   In a few moments, the disc icon appears on your screen.

   If you insert an audio CD, its icon appears on your computer screen with the name Audio CD and a number. If you insert a CD-ROM disc with audio tracks, its icon appears with the name of the disc.

5. Open the Apple () menu.

   Either the AppleCD Audio Player or CD Remote should appear in the menu.

   If no audio CD software appears, you must reinstall it before you can use your CD-ROM drive to play audio CDs or audio tracks. See Chapter 4, "Reinstalling CD-ROM Software."

6. Select AppleCD Audio Player or CD Remote—whichever is on your computer.

   Your audio CD software window appears.

   ![If you have the AppleCD Audio Player, your window looks like this.]
You can now use your audio CD software to select and play audio tracks.

*If you have the AppleCD Audio Player,* see “Using the AppleCD Audio Player,” next, for information on using that software to control audio discs and audio tracks.

*If you have CD Remote,* see “Using CD Remote,” later in this chapter, for information on using that software to control audio discs and audio tracks.

**Using the AppleCD Audio Player**

The AppleCD Audio Player window must be open in order for you to use it to control audio CDs and audio tracks. To open the player, select it from the Apple (🍎) menu.

The AppleCD Audio Player looks and works much like the controls for a typical audio CD player. You can open the player and start playing an audio CD or audio track at any time. When you close the player (the way you close any window on your Macintosh screen), the CD or audio track continues playing.

When a CD is first placed in the CD-ROM drive, the player is set to begin with Track 1. You click the Track buttons to select any track and click the Play/Pause button to begin playing. As the disc plays, the player shows the current track and an audio time.
When your CD-ROM drive is empty, the player shows no information in the Track and time display. When your CD-ROM drive contains a CD-ROM disc with no audio tracks, dashes appear across the Track and time display.

**Basic controls**

![Basic controls](image)

There are also keys you can use to control some of the player functions. See “Keyboard Alternatives,” later in this section.

**Track and time display/Clock button**

Shows the track currently being played and an audio time. There are several time options: Track Elapsed Time, Track Remaining Time, Disc Elapsed Time, and Disc Remaining Time. To change your time options, place the pointer on the Clock (\(\mathbb{F}\)) button and press and hold down your mouse button. In the pop-up menu that appears, select an option. The time option currently shown has a checkmark next to it.

![Stop](image)

**Stop**

Stops playing the audio disc or track and resets the track number to 1. You can also press the Delete key on your keyboard to stop playing the CD.

![Play/Pause](image)

**Play/Pause**

Starts playing at the beginning of the track. The button changes from Play (an arrow) to Pause (two small bars). Click the Pause button to pause the track. The button changes again. To resume playing, click the Play button once more. You can also press the Space bar or Enter key to play or pause a track.
Eject

Stops playing the audio CD or audio track and ejects the CD. You can also simultaneously press the $\$E and $E keys to eject the disc.

Volume control

Adjusts the volume for the built-in speaker or for headphones or speakers that are attached to your computer. Drag the slider up to increase volume and down to decrease it. You can also use the Up Arrow key to increase volume and the Down Arrow key to decrease volume.

Scan backward and forward

Moves rapidly backward or forward through a track while the track is playing. You can hear the track as it scans.

Previous and next track

Moves to the beginning of the previous or next track. You can also use the Left Arrow key to move to the previous track and the Right Arrow key to move to the next track.

Keyboard alternatives

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard alternative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>Delete</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Space bar or Enter</td>
</tr>
<tr>
<td>Eject</td>
<td>$$E-E</td>
</tr>
<tr>
<td>Volume control</td>
<td>Up Arrow (increase) and Down Arrow (decrease)</td>
</tr>
<tr>
<td>Previous track</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Next track</td>
<td>Right Arrow</td>
</tr>
</tbody>
</table>
Additional controls

Tracks pop-up menu

Allows you to quickly select and play a specific track without using the Play/Pause or Next and Previous Track buttons. The CD starts playing at the beginning of the selected track. The track currently selected has a checkmark next to it.

Repeat

Plays the CD continuously in the playing mode you've selected. Play starts over at the end of the CD. When the Repeat button is on, the button changes from a straight to a circular arrow.

Playing modes

Allows you to play audio CDs and audio tracks on a CD-ROM disc in one of three modes. To select a mode, click the desired button. An indicator light appears above the selected mode.

- Normal
  Plays tracks in order (1, 2, 3, and so on).

- Shuffle
  Plays tracks in random order.

- Program
  Allows you to list audio tracks in the order you want them played. For more information on using this mode, see "Creating Your Own Order for Playing Tracks," later in this chapter.
Track Edit button

Expands the player window to display the title, order, and time of individual tracks and the name of the disc. The expanded window is called the Track Edit window. Each playing mode has a Track Edit window that opens below the AppleCD Audio Player window. A scroll bar appears on the right side of the window if not all tracks can be seen.

You can use the Track Edit window to edit certain information. Your changes are automatically saved and remembered the next time you use that disc.

- In the Normal and Shuffle modes, you can edit the track and CD titles, but you can't change the order of tracks.
- In the Program mode, you can change the order of tracks and edit the title of the CD, but you can't edit the track titles.

You can move around in the Track Edit window with your mouse, or by pressing the Tab or Return key.

To close the Track Edit window, click the Track Edit button again. The Track Edit button points up when the window is open and down when it's closed.

Close box

Allows you to close the window of the AppleCD Audio Player. You can listen to an audio CD or audio tracks on a CD-ROM disc even if the player window is closed.
Options menu

You can change certain features of the AppleCD Audio Player using the Options menu.

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Color</td>
</tr>
<tr>
<td>Sound</td>
</tr>
</tbody>
</table>

Each menu command has a pop-up menu, allowing you to make the choices described below.

- **Window color**
  You can choose one of several colors in which to display the AppleCD Audio Player window. The currently chosen color has a checkmark next to it.

- **Indicator color**
  You can choose one of several colors in which to display the indicator lights within the AppleCD Audio Player. The currently chosen color has a checkmark next to it.

- **Sound**
  You can change the way you hear the audio through your computer's built-in speaker, through headphones, or through external speakers. You can choose left channel only, right channel only, or stereo. The currently chosen sound option has a checkmark next to it.

- **StartUp CD Drive**
  If you have more than one CD-ROM drive, you can choose the drive you want to use with the AppleCD Audio Player by choosing its SCSI (Small Computer Systems Interface) ID number. If you change the SCSI ID number, you must close or quit the AppleCD Audio Player and reopen it for the change to take effect.
Creating your own order for playing tracks

You can create a customized Play List for any CD that contains audio tracks. You choose the tracks you want to play and the sequence in which to hear them.

To create a customized Play List:

1. **Click the Program button.**
2. **Click the Track Edit button.**

The Track Edit window for the Program mode appears beneath the player.

3. **Drag tracks from the Track List to the Play List.**

Drag each track title to the desired position on the Play List. As you drag a track, a small arrow appears to show you where the track will be inserted.

To remove a track title from the Play List, drag the track title back to the Track List.
4 If desired, rearrange the Play List in a different order.

Drag track titles in the Play List to reorder them. The Play List you create is automatically saved, and the next time you use this CD in the Program mode, your new Play List will be displayed.

5 Click the Track Edit button to close the Track Edit window.

If you want to make any changes to your Play List in the future, you must open the Track Edit window while you are in Program mode.

To play a customized Play List:

1 Start up your Macintosh computer, if it’s not already on.
2 Press the Open/Close button to open the tray of the CD-ROM drive.
3 Place the audio CD (or the CD-ROM disc with audio tracks) in the tray, with the disc label facing up.

Make sure the disc is lying flat in the tray.

4 Push the tray in, or press the Open/Close button, to close the tray.
5 Select the AppleCD Audio Player from the Apple () menu.

The AppleCD Audio Player window appears.

6 Choose the Program mode.
7 Click the Play/Pause button.

You will hear the tracks in the order they appear on your Play List for this particular CD.

Another way to start audio tracks

If you open the icon for an audio CD or a CD-ROM disc with audio tracks, you see audio track icons labeled Track 1, Track 2, and so on. You can play a track by opening its track icon.

- Double-click a track icon to start playing it.

IMPORTANT If you select one of the track icons and choose Get Info from the File menu, you see the track’s playing time. If you copy an audio track icon to a floppy disk or hard disk, the icon is copied but the copy isn’t usable.
To close or quit the AppleCD Audio Player

When you don’t need to control an audio CD or audio tracks on a CD-ROM disc, you can close or quit the AppleCD Audio Player.

- Click the close box in the upper-left corner of the player window.
- Choose Close from the File menu, or simultaneously press the ⌘ and W keys.
- Choose Quit from the File menu, or simultaneously press the ⌘ and Q keys.

**IMPORTANT** You can listen to an audio CD or CD-ROM disc with audio tracks in the background while you use your computer for other work. After you insert the CD and press the Play/Pause button, you can close or quit the AppleCD Audio Player and start up other applications. When you want to turn off the CD, change tracks, or change CDs, select the AppleCD Audio Player from the Apple (•) menu and make the necessary changes.

Using CD Remote

The CD Remote player must be open in order for you to use it to control audio CDs and audio tracks. To open this program, select it from the Apple (•) menu.

**IMPORTANT** If you have more than one CD-ROM drive, CD Remote will work only with the drive that has the lowest SCSI ID number. For more information on SCSI ID numbers, see “Problems Starting Up Your Computer” in Chapter 5.

CD Remote looks and works much like a typical remote control unit. You can open the player and start playing an audio CD at any time. When you close the player (the way you close any window on your Macintosh screen), the disc continues playing.

When a CD is first placed in the CD-ROM drive, the player is set to begin with Track 1. You click the Track buttons to select any track and click the Play button to begin playing. As the disc plays, the player shows the current track and an audio time.
When the CD-ROM drive is empty, CD Remote displays the message "no disc" and shows zeros for the track number and time display. When a disc with no audio tracks is in the drive, zeros appear across the display.

**IMPORTANT** If you open the icon for an audio CD or a CD-ROM disc with audio tracks, you see audio track icons labeled Track 1, Track 2, and so on. You can't play an audio track by opening its track icon. If you select one of the track icons and choose Get Info from the File menu, you see the track's playing time. If you copy an audio track icon or an audio CD icon to a disk, the icon is copied, but the copy isn't usable.

### Basic controls

- **Play button**
- **Stop button**
- **Pause button**
- **Track number**
- **Time display**
- **Scan backward and forward**
- **Eject button**
- **Volume control**

**Stop**

Stops playing the audio disc or track and resets the track number to 1.

**Play**

Starts playing at the beginning of a track, unless you paused while the track was playing. In that case, play continues from the point at which you paused.

**IMPORTANT** If you are playing audio tracks on a CD-ROM disc, you may notice that one or more of the listed tracks don't play. Such tracks contain data used by your computer; they are not audio tracks.
Pause

Stops play without losing your place on the CD. To resume play, click the Pause button again or click the Play button.

Track number and time display

Shows the current track number and the elapsed time or remaining time on the track. (To change the time display, use the Time button.)

Previous and next track

Moves to the beginning of the previous or the next track.

Scan backward and forward

Moves rapidly backward or forward through a track while in the Play mode. You can hear the track as it scans.

Eject

Ejects the CD-ROM tray from your computer. You can also drag the audio CD icon to the Trash to eject the disc. The disc icon then disappears from the desktop.

Volume control

Adjusts the volume for the built-in speaker or for headphones or speakers attached to your computer. Drag the slider to the right to increase volume and to the left to decrease volume.
Additional controls

**Zoom box**
Expands the player window to display the titles of individual tracks and the name of the disc. You can edit track titles and the name of the CD in any playing mode, but you can change the order of tracks only in the Program mode. (See “Creating Your Own Order for Playing Tracks,” later in this section.)

**Audio channels**
If you have speakers attached to your computer, your player automatically filters sound through both of them. If you want to use only one speaker, click the left audio channel button to turn off the sound in the left speaker, or the right button to turn off the sound in the right speaker.

**Repeat**
Use the button to repeat an entire CD. Use the button to repeat a specific section within one audio track on a CD.
button

Plays the CD continuously in the playing mode you've selected. Play starts over at the end of the CD.

button

Allows you to set markers within one audio track on a CD and play the section between markers continuously.

To specify markers and play a section repeatedly:

1. Click the Play button.
2. With the Scan and Track buttons, go to the place just before the section you want to repeat.
3. Click the AB button.
   The label on the button changes to A.
4. When the audio passage reaches the place where you want to set the first marker, click A.
   The beginning marker is set, and the label on the button changes to B.
5. When the audio passage reaches the place where you want to set the end marker, click B.
   The end marker is set, and the label on the button changes to C.
   The section you've marked plays repeatedly until you click the button again.

To cancel the markers:
- Click the button. The label on the button changes back to A.

Program

Allows you, when Program is on, to list audio tracks in the order you want them played. You can also edit track and CD names if desired. For more information on using this mode, see “Creating Your Own Order for Playing Tracks,” later in this section.
Shuffle

Plays tracks in random order when Shuffle is on.

Time button

Switches between displaying the elapsed time and the remaining time on the track in the Time display area.

Creating your own order for playing tracks

You can create a customized Play List for any CD that contains audio tracks. You choose the tracks you want to play and the sequence in which to hear them.

To create a customized Play List:

1. Click the zoom box.

The window expands to show the Play List.
2 If you wish, click a track or the disc title and type a new name for it.

You can type any name you wish.

3 Select the tracks you want to include on your Play List.

A checkmark indicates that a track is selected. Click in the column to the left of the track to add a checkmark. Click the checkmark to remove it. (Tracks with no checkmark remain in the list, but they aren't played.)

4 Save your newly created Play List or revert to the last saved Play List.

- To save the Play List you just created, click the Save button.
- To cancel the Play List you just created and revert to the last saved Play List, click the Revert button.

Whichever Play List you saved will be recalled the next time you use this audio CD.

5 Click the zoom box to return to the original player window.

If you want to make any changes to your Play List in the future, you must click the zoom box to open the expanded window.

To play a customized Play List:

1 Click the Program button to On.

2 Click the Play button to hear your saved Play List.

You will hear the tracks in the order they appear on your Play List.

To hear tracks in their original playing order, click the Program button to Off, and then click the Play button.
To close or quit CD Remote

When you don't need to control an audio CD or audio tracks, you can close or quit CD Remote.

- Click the close box in the upper-left corner of the CD Remote window.
- Choose Close from the File menu, or simultaneously press the ` and W keys.
- Choose Quit from the File menu, or simultaneously press the ` and Q keys.

IMPORTANT  You can listen to an audio CD or audio tracks even if you close or quit CD Remote.
You can use your CD-ROM drive to open Photo CD images stored on Photo CDs. A Photo CD image is a digitized version of a standard photograph that you can open and view on your computer screen.
Obtaining Photo CDs

Your own photographs can be recorded as Photo CD images on a Photo CD. To obtain a Photo CD of your own photographs, take your standard 35-mm film to a photofinisher who has a Photo CD system. The photofinisher develops your film, digitizes the photographs, and gives you back a Photo CD containing your Photo CD images. A single Photo CD can hold approximately a hundred images.

If your Photo CD isn’t full, you can take it back to the photofinisher and have more photos added until the disc is full. Such discs are called multisession discs because they contain images added after the first session. Your CD-ROM drive can read both single-session and multisession Photo CDs. (Other CD-ROM drives can read only single-session discs and are unable to read the additional images placed on a multisession disc.)

Using Photo CDs

You can do many things with the images on your Photo CDs:

- Open and view the images individually on your computer screen. (See “Viewing the Contents of a Photo CD,” later in this chapter.)
- View the images on your computer screen in a series, as you would view a slide presentation. (See “Viewing Several Images in Sequence.”)
- Copy and save the images, print them, paste them into word-processing documents or other documents that accept graphics, and edit them with a graphics application. (See “Working With Photo CD Images in Other Programs.”)

Photo CD images are an excellent source of graphics for desktop publishing, multimedia presentations, business documents, and professional-quality graphic design.
IMPORTANT To view Photo CD images on your Macintosh, you must have QuickTime 1.6.1 or later and Apple Photo Access in your System Folder. In most cases, QuickTime and Apple Photo Access are already installed. To check the version of QuickTime or to reinstall QuickTime, see “About the QuickTime Extension” in Chapter 4. To reinstall Apple Photo Access, see the appropriate section in Chapter 4.

- If you have a Performa computer, see “Do You Have a Performa Computer?”
- If your computer came with an internal CD-ROM drive, you also received an accessory kit that includes a CD containing your system software. See “Reinstalling CD-ROM Software From a CD.”
- If you originally purchased your computer without an internal CD-ROM drive and later upgraded to add this CD-ROM drive to your system, your CD-ROM software is on a floppy disk. See “Reinstalling CD-ROM Software From a Floppy Disk.”

You don't work directly with QuickTime and Apple Photo Access. They work behind the scenes with your system software. QuickTime lets your programs integrate graphics, sound, video, and animation into documents. Apple Photo Access lets you work with Photo CD images.

Before viewing the contents of a Photo CD

You open Photo CD images with TeachText or SimpleText, unless you select a graphics or image-editing program to open images. To select a different program to open images, see “Setting Preferences for How Photo CD Images are Displayed” later in this chapter. If you use TeachText or SimpleText to view high-resolution images, you should increase the amount of memory those programs use. To change the amount of memory a program uses, see the manuals or on-screen help that came with your computer.
Viewing the contents of a Photo CD

You can view and work with your Photo CD images using many popular graphics applications. Your images open in TeachText or SimpleText unless you specify that they should open in another program. (See "Setting Preferences for How Photo CD Images Are Displayed," later in this chapter, for instructions on choosing another program.)

To view images on a Photo CD:

1. Start up your Macintosh computer, if it's not already on.
2. Press the Open/Close button to open the tray of the CD-ROM drive.
3. Place your Photo CD in the tray, with the disc label facing up.
   Make sure the disc is lying flat in the tray.
4. Push the tray in, or press the Open/Close button, to close the tray.

The first time you insert a Photo CD, a message appears telling you the system is creating a Photo CD icon. Click Stop if you want the system to use generic document icons instead.

After a few moments, an icon for the Photo CD appears on the desktop. The disc name has the letters “PCD” and an identifying number supplied by the photofinisher. You cannot change the name of the disc.

By the way: If you chose generic document icons and later decide you want Photo CD icons instead, you can create them by holding down the ⌘ and Option keys as you insert the Photo CD. Continue holding down the ⌘ and Option keys until the disc icon appears.
Double-click the disc icon to open the Photo CD window.

A Photo CD window always contains a Slide Show, the Slide Show Viewer, and a Photos folder. With the Slide Show movie and Slide Show Viewer (described in “Viewing Several Images in Sequence,” later in this chapter), you can view your images as if you were browsing through slides. The Photos folder holds your Photo CD images.

The Photo CD window also contains a PHOTO_CD folder that holds technical information about your Photo CD images. Normally, you won’t need to use this folder.

Double-click the Photos folder to open it.

You see five folders. Each folder contains all your Photo CD images recorded at a particular resolution. For more information on resolution, see “A Note About Resolution” later in this chapter.
Double-click the folder for the resolution at which you want to see images.

Within each folder, an icon appears for each Photo CD image. Each icon is a tiny representation of a Photo CD image. The name of each icon corresponds to the index (and sequence) number of the image. (The index comes with your Photo CD but you can’t view it.)

**IMPORTANT** When your system is low on memory, your computer may have problems displaying color icons for the images on a Photo CD. Although some icons may appear as black-and-white document icons, the Photo CD images themselves are not affected. To view the color icons, quit all open programs, restart your computer, and then reopen the Photos folder. See the manuals or on-screen help that came with your computer for more information on managing memory.
Double-click the icon of the image you want to see.

The image appears in a window opened by TeachText or SimpleText. You can choose to have Photo CD images opened by a graphics program instead (see "Setting Preferences for How Photo CD Images Are Displayed," later in this chapter).

You can now view and print the image. You can also copy and paste the image into your Scrapbook, or into other documents or graphics programs.

**IMPORTANT** Because your images are recorded on a "read-only" CD-ROM disc, you can't rename them. However, you can copy your Photo CD images to a hard disk or floppy disk, and then you can rename and change the images just as you can other Macintosh documents.
Viewing several images in sequence

You can browse through all your Photo CD images by using the Slide Show and the Slide Show Viewer in the Photo CD window. The Slide Show is a QuickTime movie of all your Photo CD images.

To play the Slide Show movie:

1. Start up your Macintosh computer, if it's not already on.
2. Press the Open/Close button to open the tray of the CD-ROM drive.
3. Place your Photo CD in the tray, with the disc label facing up.
   Make sure the disc is lying flat in the tray.
4. Push the tray in, or press the Open/Close button, to close the tray.
   After a few moments, an icon for the Photo CD appears on the desktop.
5. Double-click the disc icon to open the Photo CD window.

   ![Photo CD window]

6. Double-click the Slide Show icon.
   The Slide Show Viewer automatically begins displaying Photo CD images.
7 Use the Slide Show Viewer controls to stop or start the movie, scroll to particular images, or move forward or backward through the images.

You can also go to an image by typing its number.

To go to a different image, type a new image number here.

Click to start or stop.

Drag to scroll to a different image.

Drag to resize the viewer window.

Click to move forward or backward through the images.

Setting preferences for how Photo CD images are displayed

You can choose how images are displayed on your screen with the Preferences command in the Slide Show Viewer. The display options include

- which program will automatically open Photo CD images
- which resolution is used
- how large the images appear on the screen when you view them as a slide show

To set your preferences for viewing Photo CD images:

1 Double-click the Slide Show Viewer icon to open it.
2 Choose Preferences from the File menu.

The Preferences dialog box appears. You can check the current options and make any changes you want.

To choose one of these two sizes, click a button.

To add or remove programs in the Using pop-up menu, click one of these buttons, and in the dialog box that appears, specify the program you want to add or remove.

To choose another size (resolution), open this pop-up menu.

To choose a program for opening Photo CD images, open this pop-up menu.

IMPORTANT If you see an error message when you select a program for opening Photo CD images, it means you can't double-click an image to open it in this program. However, you may still be able to open your Photo CD images from within this program by opening the program and then choosing the Open command. (See the manuals that came with your program for instructions on opening files from within it.)

3 After you've chosen the options you want, click OK to close the Preferences dialog box.

4 Restart your Macintosh.

Your changes take effect after you restart your Macintosh. Then, whenever you double-click a Photo CD image, it opens in the selected program and at the resolution and size you specified.
A note about resolution

When a Photo CD image is created, it's recorded at five different levels of resolution. The resolution level of an image determines the amount of information recorded for it, which in turn determines how well the image can be displayed or printed. The higher the image resolution, the more information that is recorded for it.

High-resolution images can contain as much as 18 MB of data for one photograph. However, depending on your computer's screen resolution or your printer's printing resolution, you may not be able to view or print the graphic at such high resolution.

You can select and work with an image at a resolution appropriate for your display or printing device. For most work, an image resolution of 768 x 512 pixels or smaller is suitable. For more detailed work or for very high-quality reproductions, you may want to use a larger image resolution.

You should open larger images with application programs designed to handle large image files. TeachText and SimpleText will have difficulty opening large files.

Working with Photo CD images in other programs

You can work with your Photo CD images in a variety of programs other than the Slide Show, TeachText, and SimpleText. There are several ways to open and work with Photo CD images in other programs:

- You can set a default program so that when you double-click a Photo CD image, the image automatically opens in the program you chose. See "Setting Preferences for How Photo CD Images Are Displayed," earlier in this chapter.

- You can transfer a displayed image to the default program or to any other program while you are in the Slide Show Viewer. See "Transferring the Displayed Image to Another Program," next.

- You can also copy and paste images. See "Copying Images from a Slide Show Movie" later in this chapter.
Once you've opened the image in a program, you can change the image and save your changes on a hard disk or floppy disk. You can't save any changes to your Photo CD because it is a "read-only" disc.

**Transferring the displayed image to another program**

When you are looking at an image with the Slide Show Viewer, you can use the Photos menu to transfer the image into another program. You can keep the current settings in the Preferences dialog box, or you can change them.

To transfer the image with the current settings in the Preferences dialog box:
- While the image you want is displayed, choose View from the Photos menu (or double-click on the image).

  The image opens in the program and at the resolution you specified in the Preferences dialog box.

To transfer the image with new settings:

1. **While the image you want is displayed, choose View As from the Photos menu.**
2. **In the dialog box that appears, choose a resolution from the Size pop-up menu.**

   ![Dialog Box](Image)

3. **From the Using pop-up menu, choose a program to open the image.**

   If the program in which you want to open the image is not in the Using pop-up menu, click Add. In the dialog box that appears, specify the program you want to add.

   To remove a program from the list, click Remove. In the dialog box that appears, specify the program you want to remove.

4. **When you've chosen the options you want, click OK.**

   The image opens in the program and at the resolution you specified.
Copying images from a Slide Show movie

You can also copy a Slide Show image and paste it into any document that accepts images.

To copy an image at the current resolution in the Preferences dialog box:

1. While the image you want to copy is displayed, choose Copy from the Edit menu.
2. Open the document you want to paste the image into.
3. Choose Paste from the Edit menu.

The image appears in your document, where you can work with it and save it on a hard disk or floppy disk.

To copy the image at a different resolution:

1. While the image you want to copy is displayed, choose Copy As from the Edit menu.
2. In the dialog box that appears, choose a resolution from the Size pop-up menu.

3. Click OK.
4. Open the document you want to paste the image into.
5. Paste the image into the document.

The image appears in the document, where you can work with it and save it on a hard disk or floppy disk.

Working With Photo CD Images
Copying a Slide Show movie onto another disk

You can copy the Slide Show movie to a hard disk or a floppy disk and use it to browse through and work with the images on the Photo CD.

**IMPORTANT** You can't copy a Slide Show movie by dragging its icon to a hard disk or floppy disk because there will be no link between the movie and the new Photo CD icon. Although the icon itself will be copied, you won't be able to use the new icon to view the Slide Show movie.

To copy the Slide Show movie:

1. Double-click the Slide Show icon to open it.
2. Choose Save a Copy from the File menu.
   The Compression Settings dialog box appears.
3. Select various copy options.
   Specify whether you want color or grayscale images to be copied. If you wish, you can also specify a compression method and the quality of the copy.
4. Click OK.
5. Choose a location to store the copy and type a name for the copy, then click Save.
   The movie is saved on a hard disk or floppy disk. You can now use this copy to view the Slide Show movie.
Reinstalling CD-ROM Software

In most cases, all the software required for using your CD-ROM drive is already installed on your computer and ready to use. Follow the instructions in this chapter only if you need to reinstall the software for any reason. To check whether you need to reinstall the software, see "Is Your CD-ROM Software Already Installed?" in Chapter 1.

There are different ways to reinstall the CD-ROM software. The method you use depends on how you received your software:

- If you have a Performa computer, see "Do You Have a Performa Computer?"
- If your computer came with an internal CD-ROM drive, you also received an accessory kit that includes a CD containing your system software. See "Reinstalling CD-ROM Software From a CD."
- If you originally purchased your computer without an internal CD-ROM drive and later upgraded to add this CD-ROM drive to your system, your CD-ROM software is on a floppy disk. See "Reinstalling CD-ROM Software From a Floppy Disk."
Reinstalling CD-ROM software from a CD

In the accessory kit that came with your CD-ROM drive is a CD containing your system software. You can use this CD to reinstall the CD-ROM software. (To find out if you need to reinstall the software, see “Is Your CD-ROM Software Already Installed?” in Chapter 1.) In most cases you will want to reinstall all of the software, and you can follow the instructions in “Reinstalling All the Software.” If for some reason you want to reinstall only part of the software, see “Reinstalling Only Specific Parts of the Software.”

IMPORTANT To view Photo CDs, you must have the extensions QuickTime 1.6.1 or later and Apple Photo Access in your System Folder. To check the version of QuickTime on your computer or to reinstall QuickTime, see “About the QuickTime Extension,” later in this chapter. Apple Photo Access is part of the CD-ROM software and is installed when you install all the CD-ROM software. If you choose to install only part of the software, make sure you install the Foreign File System, which contains Apple Photo Access.

Reinstalling all the software

If you need CD-ROM software, you’ll probably want to reinstall all the software.

IMPORTANT Do not put the CD containing your system software into the CD-ROM drive until after you start up your computer.

1 Start up your Macintosh computer, if it's not already on.

2 Press the Open/Close button to open the tray of the CD-ROM drive.

The tray opens.
3 Place the CD with your system software in the tray, with the disc label facing up.
Make sure the disc is lying flat in the tray.

4 Push the tray in, or press the Open/Close button, to close the tray.
In a few moments, the disc icon appears on your screen.

5 Double-click the disc icon to open it.
The disc window appears.

6 Double-click the CD-ROM Setup folder to open it.
The Installer icon appears.

7 Double-click the Installer icon to open it.
The Easy Install dialog box appears.

8 Click Install.
The required files are automatically installed and placed in the System Folder on the selected hard disk.

9 When you see a message reporting that installation was successful, click Restart.
Your Macintosh restarts. You can now use your CD-ROM drive. (If a message reports that installation was not successful, follow the instructions on screen to try installing the software again.)
Reinstalling only specific parts of the software

When you need only specific parts of the CD-ROM software, follow these instructions to do a custom installation. If you want to use audio CDs, Photo CDs, or ISO 9660/High Sierra discs, you must install both the CD-ROM System Driver Software and the Foreign File System.

IMPORTANT Do not put the CD containing your system software into the CD-ROM drive until after you start up your computer.

1. Start up your Macintosh computer, if it’s not already on.
2. Press the Open/Close button to open the tray of the CD-ROM drive.
3. Place the CD with your system software in the tray, with the disc label facing up.
   Make sure the disc is lying flat in the tray.
4. Push the tray in, or press the Open/Close button, to close the tray.
   In a few moments, the disc icon appears on your screen.
5. Double-click the disc icon to open it.
   The disc window appears.
6. Double-click the CD-ROM Setup folder to open it.
   The Installer icon appears.
7. Double-click the Installer icon to open it.
   The Easy Install dialog box appears.
8 Click Customize.

Your installation choices appear.

Click to select the files you want installed on the selected hard disk. (Your software choices may be different from these.)

When you're ready to begin, click Install.

Make sure this disk is where you want the software to be.

To switch to a different disk, click Switch Disk until the name of the correct disk appears.

9 From the list in the dialog box, select the portions of the software you want to install.

As you select an item, a description of that item appears below the list of items. To select more than one item to install, hold down the Shift key as you click.

Be sure to select the software appropriate for your computer's version of system software. (To check the version of system software you have, go to the Finder, pull down the Apple [ ] menu, and select “About This Macintosh.” You'll find the version number in the window that appears.)

10 Click Install.

The selected files are automatically installed and placed in the System Folder on the selected hard disk.

11 When you see a message reporting that installation was successful, click Restart.

Your Macintosh restarts. You can now use your CD-ROM drive. (If a message reports that installation was not successful, follow the instructions on screen to try installing again.)
Reinstalling CD-ROM software from a floppy disk

If you originally purchased your computer without a CD-ROM drive and later upgraded to add this CD-ROM drive to your system, your CD-ROM software is on the CD Setup floppy disk. You can use this disk to reinstall the CD-ROM software. (To find out if you need to reinstall the software, see “Is the CD-ROM Software Already Installed?” in Chapter 1.) In most cases you will want to reinstall all of the software, and you can follow the instructions in “Reinstalling All the Software.” If for some reason you want to reinstall only part of the software, see “Reinstalling Only Specific Parts of the Software.”

IMPORTANT To view Photo CDs, you must have the extensions QuickTime 1.6.1 or later and Apple Photo Access in your System Folder. To check the version of QuickTime on your computer or to reinstall QuickTime, see “About the QuickTime Extension,” later in this chapter. Apple Photo Access is part of the CD-ROM software and is installed when you install all the CD-ROM software. If you choose to install only part of the software, make sure you install the Foreign File System, which contains Apple Photo Access.

Reinstalling all the software

If you need CD-ROM software, you’ll probably want to install all the software.

1 Insert the CD Setup disk into the internal floppy disk drive.

If your Macintosh has two floppy disk drives, you can use either one. In a few moments, the disk icon appears on your screen.

2 Double-click the disk icon to open it.

The disk window appears.
3 Double-click the Installer icon to open it.

The Easy Install dialog box appears.

![Easy Install dialog box]

Make sure this disk is where you want the software to be.

When you're ready to begin, click Install.

To switch to a different disk, click Switch Disk until the name of the correct disk appears.

4 Click Install.

The required files are automatically installed and placed in the System Folder on the selected hard disk.

5 When you see a message reporting that installation was successful, click Restart.

Your Macintosh restarts. You can now use your CD-ROM drive. (If a message reports that installation was not successful, follow the instructions on screen to try installing the software again.)

Reinstalling only specific parts of the software

When you need only specific parts of the CD-ROM software, follow these instructions to do a custom installation.

IMPORTANT To use audio CDs, Photo CDs, or ISO 9660/High Sierra discs, you must install both the CD-ROM System Driver Software and the Foreign File System.
1 Insert the *CD Setup* disk into the internal floppy disk drive.

If your Macintosh has two floppy disk drives, you can use either one. In a few moments, the disk icon appears on your screen.

2 Double-click the disk icon to open it.

The disk window appears.

3 Double-click the Installer icon to open it.

The Easy Install dialog box appears.

4 Click Customize.

Your installation choices appear.

5 From the list in the dialog box, select the portions of the software you want to install.

As you select an item, a description of that item appears below the list of items. To select more than one item to install, hold down the Shift key as you click.

Be sure to select the software appropriate for your computer's system software version. (To check the system software version you have, go to the Finder, pull down the Apple [Apple] menu, and select “About This Macintosh.” You'll find the version number in the window that appears.)
6 Click Install.

The selected files are automatically installed and placed in the System Folder on the selected hard disk.

7 When you see a message reporting that installation was successful, click Restart.

Your Macintosh restarts. You can now use your CD-ROM drive. (If a message reports that installation was not successful, follow the instructions on screen to try installing again.)

Do you have a Performa computer?

If you have a Performa computer and you need to reinstall the CD-ROM software for any reason, you can use the backup copy of your software. (To find out if you need to reinstall the software, see “Is Your CD-ROM Software Already Installed?” in Chapter 1.) See the manuals that came with your computer for further instructions on making and using backup copies of your software.

If you do not have a backup copy or you cannot use your backup copy, contact Apple to get information on obtaining the CD-ROM software. See the service and support information that came with your computer for details.
About the QuickTime extension

To view images on Photo CDs, you must have QuickTime 1.6.1 or later.

Seeing if QuickTime is installed

1. Double-click your startup hard disk icon to open it.
2. Double-click the System Folder to open it.
3. Double-click the Extensions folder to open it.

*If the QuickTime icon is in the window,* you know QuickTime is installed. Go on to “Seeing if You Have the Correct Version of QuickTime,” next in this section.

*If the QuickTime icon is not in the window,* you know QuickTime is not installed. See “Determining How You Should Install QuickTime” in this section.

Seeing if you have the correct version of QuickTime

1. In the Extensions folder window, select the QuickTime icon.

If you don’t see this window, see “Seeing if QuickTime Is Installed.”

2. Choose Get Info from the File menu.

A window appears with the name and version of the software. If you have QuickTime 1.6.1 or later, you do not have to reinstall QuickTime. If you do not have QuickTime 1.6.1 or later, you must install it. (See “Determining How You Should Install QuickTime,” next in this section.)

Determining how you should install QuickTime

- If you have a Performa computer, use the backup copy of your software to reinstall QuickTime. If you do not have a backup copy, contact Apple to get information on obtaining the QuickTime software.
- If you have a CD with your system software on it, see “Installing QuickTime From a CD” next in this section.
- If you have a Quic Tim e floppy disk, see “Installing QuickTime From a Floppy Disk” in this section.
Installing QuickTime from a CD

The accessory kit that came with your CD-ROM drive includes a CD that contains your system software. You can use this CD to install QuickTime. (To find out if you need to install QuickTime, see “Seeing if QuickTime Is Installed.”)

Follow these instructions to install the QuickTime extension.

1. Press the Open/Closed button to open the tray of the CD-ROM drive.
2. Place the CD with your system software in the tray, with the disc label facing up.
   Make sure the disc is lying flat.
3. Push the tray in, or press the Open/Closed button, to close the tray.
   In a few moments, the disc icon appears on your screen.
4. Double-click the disc icon to open it.
   The disc window appears.
5. Double-click the QuickTime folder to open it.
6. Click the QuickTime extension icon to select it, and then drag the icon to your System Folder icon.
   A message appears saying that QuickTime must be placed in the Extensions folder.
7. Click OK.
   The correct version of QuickTime is installed in your System Folder.
8. Restart your Macintosh.
Installing QuickTime from a floppy disk

If you originally purchased your computer without a CD-ROM drive and later upgraded to add this CD-ROM drive to your system, you received the QuickTime floppy disk, which you can use to install the QuickTime extension. (To find out if you need to install QuickTime, see “Seeing if QuickTime Is Installed.”)

Follow these instructions to install the QuickTime extension.

1. **Insert the QuickTime disk into the internal floppy disk drive.**

   If your Macintosh has two floppy disk drives, you can use either one. In a few moments, the disk icon appears on your screen.

2. **Double-click the QuickTime disk icon to open it.**

   The disk window appears.

3. **Click the QuickTime extension icon to select it, and then drag the icon to your System Folder icon.**

   A message appears saying that QuickTime must be placed in the Extensions folder.

4. **Click OK.**

   The correct version of QuickTime is installed in your System Folder.

5. **Restart your Macintosh.**
Troubleshooting

This chapter describes solutions to problems you may encounter while using your CD-ROM drive.

Many problems can be caused by improper installation of the CD-ROM software. If you have to reinstall the software, make sure you install it exactly as described in Chapter 4.

If the suggestions in this chapter don’t solve your problem, refer to the service and support information that came with your computer for information on obtaining technical assistance.
Problems starting up your computer

The computer doesn't seem to know that there is an internal CD-ROM drive.

- Make sure the CD-ROM software that came with your CD-ROM drive is installed. (See "Is the CD-ROM Software Already Installed?" in Chapter 1.)
- If you reinstall the CD-ROM software, make sure to restart your computer after you reinstall the software.
- Do you have other SCSI devices attached to your computer? Make sure that each SCSI device attached to your computer has a unique SCSI ID number. You should not have two CD-ROM drives with the same SCSI number. The SCSI ID number of your internal CD-ROM drive is 3. The ID number for other Apple devices often appears on the back near the SCSI ports. Refer to the manuals that came with your other SCSI devices if you need to reset SCSI ID numbers.

The computer won't restart after you've copied software for your CD-ROM drive to the System Folder.

- If you attempt to reinstall the software for your CD-ROM drive without using the Installer as described in Chapter 4, you may not be able to restart your computer. Remove any files you copied by dragging them to the Trash. Restart using another startup disk, and then reinstall the software according to the instructions in Chapter 4.

Your computer won't restart and there is a CD-ROM disc inside the CD-ROM drive.

- Your computer may be trying to restart from a CD-ROM disc other than the CD containing your system software. Press the Open/Close button on the front of the computer to open the tray, and remove the CD-ROM disc. Push the tray in, or press the Open/Close button, to close the tray. Restart your computer.

Your computer starts up and you see large folder-shaped areas, containing labeled pictorial buttons, instead of the usual Macintosh desktop.

- If you start up your computer when the CD containing your system software is in the CD-ROM drive, your computer uses the CD as a startup disk and you see At Ease, an alternative to the usual Macintosh desktop. You need to have the usual Macintosh desktop on your screen before you can use the installation instructions in this manual.
To return to the usual Macintosh desktop, choose Shut Down from the Special menu. When your computer is off, press the Open/Close button of your CD-ROM drive to open the tray, then remove the CD containing your system software. Push the empty tray in, or press the Open/Close button, to close the tray. Then start up your computer again.

Problems using CD-ROM discs

The tray of your CD-ROM drive won’t open.

- Press the Open/Close button for your CD-ROM drive.
- The signal to open the tray may not be reaching the computer. Turn off your computer and locate the small pinhole to the lower right of the CD-ROM tray opening. Insert the end of a large straightened paper clip firmly and horizontally into the pinhole. Push gently until the tray is released, then carefully pull the tray open. Do not force the tray open; wait until the paper clip has dislodged it or you may break the front of the tray.

**WARNING** Turn off your computer before you attempt to eject the tray using a paper clip. If you don’t turn off the computer, you may damage the CD-ROM drive.

- If neither of these suggestions works, your CD-ROM drive may be damaged. Contact an Apple-authorized service provider or Apple for further assistance.

You insert a CD-ROM disc, but its icon doesn’t appear on the Macintosh desktop.

- Make sure you place the disc in the tray with the disc label facing up so you can read it.
- Make sure the tray is closed all the way.
- Make sure the CD-ROM software is installed. (See “Is the CD-ROM Software Already Installed?” in Chapter 1.)
- Try restarting your computer.
Your computer displays the message “This is not a Macintosh disk: Do you want to initialize it?” when you insert a CD-ROM disc in the CD-ROM drive.

- Make sure the CD-ROM software is installed. (See “Is the CD-ROM Software Already Installed?” in Chapter 1.)
- The disc may use a format that the Macintosh cannot recognize. (See “Modes Supported” in the Appendix for more information.)

Your computer ejects a CD-ROM disc without giving you any error message.

- Make sure you’ve inserted the disc correctly in the tray (with the disc label facing up and the disc lying flat).
- Your computer may not be able to read information from the disc because the disc needs to be cleaned. (See “Care and Handling” in Chapter 1.)
- If these suggestions don’t work, the CD-ROM disc is probably damaged and needs to be replaced.

You can’t open a document on a CD-ROM disc.

- Try opening the application program first; then open the document.
- Read the manual that came with your CD-ROM disc. Some discs come with a separate floppy disk containing the program that reads the information from the disc.

You can’t save changes you make to information on a CD-ROM disc.

- CD-ROM is a read-only medium. This means that information can be read (retrieved) from it, but not written (stored) on it. You can save the changed information on a hard disk or floppy disk.

Problems using ISO 9660 or High Sierra discs

You cannot access files on a CD-ROM disc that uses the ISO 9660 or High Sierra format.

- Discs in the ISO 9660 and High Sierra disc formats have version numbers attached to filenames. Some application programs need these version numbers in order to work with files. To make the version numbers available to programs on your computer, follow these instructions.

Drag the CD icon to the Trash. The tray opens. Hold down the Option key and push the tray back in; continue holding down the Option key until the disc is in the drive. The program you are using should now be able to locate filenames on that CD-ROM disc.
Problems playing audio CDs

You don't hear any sound when you play an audio CD or an audio track on a CD-ROM disc using the AppleCD Audio Player or CD Remote.

- If you have headphones or speakers connected to the computer, adjust the connector to make sure you have a good connection.
- If you do not have headphones or speakers connected to the computer, make sure that nothing else is plugged into the sound output port on the back of your computer.
- Are you using a CD-ROM disc over a network? You can't hear the audio portion of discs you access over a network.

Make sure the volume is turned up in the AppleCD Audio Player or CD Remote. Pull down the Apple ( ) menu and select your audio CD software. When the player window opens, drag the volume lever to adjust the sound.

- Click the Play/Pause button once or twice. You may be in Pause mode.
- If your Macintosh has different sound recording options, you may have the options set incorrectly to hear the audio sound from a CD. Open the Sound control panel by pulling down the Apple ( ) menu, choosing Control Panels, and double-clicking the Sound control panel icon. Choose Sound In from the pop-up menu at the top of the panel, then select the Built-In icon for the audio source. Click the Options button, select Internal CD, make sure the Playthrough box is selected, and then click OK. See the manuals or on-screen help that came with your computer for more information.

You can't open a track icon on an audio CD or on a CD-ROM disc with audio tracks.

- If you have CD Remote, you can't play audio tracks by opening track icons. Open and use the CD Remote software to play audio tracks.

While playing an audio track on a CD-ROM disc that combines audio tracks and data, you double-click the disc icon and the audio track stops playing.

- You can't open data files on a CD-ROM disc and listen to audio tracks on that disc at the same time.
You are unable to record sound from an audio CD.

- Check your computer's sound input port to see if a microphone or other device is connected. Connecting a microphone or other device to the port turns off the computer's ability to record from your CD-ROM drive.

Problems using Photo CDs

Your CD-ROM drive will not open Photo CDs.

- To view Photo CD images, you must have QuickTime 1.6.1 or later and Apple Photo Access installed in your System Folder. To check the version of QuickTime on your computer or to reinstall QuickTime, see “About the QuickTime Extension” in Chapter 4.

Apple Photo Access is part of the CD-ROM software and should already be installed. If you need to reinstall Apple Photo Access, you will probably want to reinstall all the CD-ROM software. If you choose to reinstall only specific parts of the software, make sure you install the Foreign File System, which contains Apple Photo Access. For more information on reinstalling the CD-ROM software, see Chapter 4.

Your computer does not display color icons for individual images on a Photo CD.

- Your system may be low on memory. Although individual icons may appear as black-and-white document icons, the Photo CD images themselves are not affected. To view color icons for individual images, quit all open programs, restart your computer, and then reopen the Photos folder. See the manuals or on-screen help that came with your computer for more information on managing memory.

After you open an image on a Photo CD, the image is scrambled, colors are displayed incorrectly, or no image appears in the window.

- The program you are using to view the image may have difficulty opening large (high-resolution) image files. You can change the program that opens images or you can increase the memory a program uses. To select another program to open images, see “Setting Preferences for How Photo CD Images Are Displayed” in Chapter 3. To change the amount of memory a program uses, see the manuals or on-screen help that came with your computer.
After you open an image on a Photo CD, your system is "frozen" and does not respond to any input, or you have a "bomb" message on your screen.

- Restart your Macintosh by pressing the reset switch on your computer. If your computer doesn't have a reset switch, hold down the `#, Control, and Power keys to restart the computer. The program you are using to view the image may have difficulty opening large (high-resolution) image files. You can change the program that opens images or you can increase the memory a program uses. To select another program to open images, see “Setting Preferences for How Photo CD Images Are Displayed” in Chapter 3.

To change the amount of memory a program uses, see the manuals or on-screen help that came with your computer.

**WARNING** If you have a problem with your CD-ROM drive and nothing in this chapter solves it, see the service and support information that came with your computer for instructions on how to contact an Apple-authorized service provider or Apple for assistance. If you attempt to repair the CD-ROM drive yourself, any damage you may cause to your equipment will not be covered by the limited warranty on your equipment. Contact an Apple-authorized dealer or service provider for additional information about this or any other warranty question.
Appendix
Specifications

Disc
- Data surfaces: 1
- Disc diameter: 120 millimeters (mm)
- Disc center hole diameter: 15 mm
- Thickness: 1.2 mm
- Track pitch: 1.6 microns (15,875 tracks per inch)
- Scanning velocity: 1.2–1.4 meters per second
- Rotation speed:
  - Normal speed: Varies over radius
  - Double speed: ~530 to 230 revolutions per minute (rpm)
  - ~1060 to 460 rpm
- Latency (average):
  - Normal speed: ~55 to 130 milliseconds (ms)
  - Double speed: ~27.5 to 65 ms
- Blocks per rotation: ~8.4 to 19.5 variable
- Average access time (typical):
  - Normal speed: 410 ms
  - Double speed: 295 ms
Data

- Data capacity
  - 656 megabytes (MB), Mode 1
  - 748 MB, Mode 2

- Number of blocks per disc
  - 336,150

- Data per block
  - 2048 bytes, Mode 1
  - 2336 bytes, Mode 2

- Address description
  - Minutes, seconds, blocks

Audio capacity

- Playing time
  - 74 minutes and 42 seconds

Modes supported

- Audio CD
- CD-ROM
- CD-ROM XA
- CD-I
- Photo CD

- Modes 1 and 2
- Mode 2, Forms 1 and 2
- Single session and multisession

Data streaming and transfer rates

- Blocks per second
  - Normal speed
    - 75
  - Double speed
    - 150

- User kilobytes (K) per second
  - Normal speed
    - 150K, Mode 1
    - 171.1K, Mode 2
  - Double speed
    - 300K, Mode 1
    - 342.2K, Mode 2

- SCSI bus burst rate (typical)
  - Asynchronous
    - 2.5 MB per second
  - Synchronous
    - 2.1 MB per second
Environmental

Noise (maximum)
- Drive on (seek) <50 decibels (dB)
- Drive on (non-seek) <46 dB
- Tray open/close <55 dB

Temperature
Celsius (C) and Fahrenheit (F)
- Operating temperature 5° to 55° C (41° to 131° F)
- Storage (6 months) −30° to 50° C (−22° to 122° F)
- Transient (72 hours) −40° to 65° C (−40° to 149° F)

Humidity
- Operating 5% to 90% noncondensing
- Storage 5% to 95% noncondensing

Altitude
Meters (m) and feet (ft.)
- Operating −305 to 3048 m
  (−1000 to 10,000 ft.)
- Shipping, non-operating −305 to 15,240 m
  (−1000 to 50,000 ft.)

Power requirements
- Voltage +5V DC ± 5%
  +12V DC ± 10%

Power consumption (typical)
- +5V DC 450 milliamperes (mA)
- +12V DC 420 mA
Type
- Semiconductor GaAlAs laser

Wavelength
- 790 ± 25 nanometers

Output power
- 0.2 milliwatts

Beam divergence
- 55°

Note: Some of the specifications listed above could change.
Index

- Control-Power key, for restarting computer 59
- E, for ejecting a CD-ROM disc 5, 13
- Option key, for creating Photo CD icon 30
- Q (Quit)
  in AppleCD Audio Player 19
  in CD Remote 26
- W (Close)
  in AppleCD Audio Player 19
  in CD Remote 26

A

AB button (CD Remote) 22, 23
altitude specifications 63
Apple-authorized service provider, contacting 59
AppleCD Audio Player (Apple menu)
  checking for presence of 3
  closing 11
  Options menu 16
  quitting 19
  reinstalling 3–4, 44–45
  starting up 10–11
  troubleshooting in 57–58
  using 11–19

AppleCD Audio Player window 10
  basic controls 12–15
  closing 15
  ejecting disc in 5
  opening 10
Apple menu
  audio software in. See AppleCD Audio Player; CD Remote
  checking for CD-ROM installation 3
Apple Photo Access
  for Photo CD viewing 3, 29
  reinstallation and 42, 58
arrow keys, in AppleCD Audio Player
  as Previous/Next track button alternatives 13
  as Volume control alternative 13
At Ease 54
audio
  file-sharing feature and 8
  problems with 57–58
Audio CD icon 10
  copying caution 20
  ejecting discs with 21
audio CDs 9–26
  compatibility with CD-ROM drive 1, 3
  problems playing 57
  problems recording from 58
software for 9. See also AppleCD Audio Player; CD Remote
Audio channel buttons (CD Remote) 22
audio hardware 9
audio specifications 62
audio track icons
  in AppleCD Audio Player,
    playing by opening 18
  in CD Remote 20
copying caution 20
audio tracks
  CD-ROM drive capability 9
copying caution 18
  creating Play List for
    in AppleCD Audio Player 17–18
    in CD Remote 24–25
data files and 57
listening to in background 19
  playing by opening track icon 18, 57
problems playing 57–58
renaming, in CD Remote 24, 25
repeating, in CD Remote 22, 23
selecting, in AppleCD Audio Player
  11, 13, 14
  with Left/Right Arrow keys 13
  with Previous/Next track buttons 13
  with Tracks pop-up menu 14
viewing playing time for 18

“bomb” message 59
browsing Photo CD images 34–35

CD-I mode support 62
CD Remote (Apple menu)
  checking for presence of 3
  controls in 20–24
  creating Play List in 24–25
  multiple CD-ROM drives and 19
  quitting 26
  reinstalling 3–4
  renaming an audio track in 24, 25
  starting up 10–11, 19
  troubleshooting in 57–58
  using 19–26
CD Remote window 11, 20
  closing 26
  opening 10–11
CD-ROM disc icon
  appears on desktop 10
  does not appear on desktop 55
  opening tray with 5
CD-ROM discs
  capacity of 2
  cleaning 7
  creating Play List for
    in AppleCD Audio Player 17–18
    in CD Remote 24–25
  ejected by computer 56
  ejecting 5–6
    in AppleCD Audio Player 12, 13
    in CD Remote 21
file formats on 2
handling 7
inserting in drive 4–5
problems with 55
listening to in background 19
on network 8
  audio problems 8, 57
  ejecting problems 5
non-audio tracks on 20
problems opening document on 56
renaming 24
safety considerations 7
saving changes to information on 56
specifications 61
storing 6
troubleshooting 55–56
types of 2–3
CD-ROM drive
ejecting a disk from 5–6
inserting a disc in 4–5
multisession disc capability in 28
Photo CDs won’t open on 58
problems with 55
safety considerations vii, 6–7
troubleshooting 55
type of discs handled by 1
CD-ROM mode support 62
CD-ROM Setup folder 43, 44
CD-ROM software
checking for presence of 3
reinstalling x, 41–52
from CD Setup floppy disk 46–49
on Performa computers 49
specific parts of 44–45, 47–49
startup problems after 54–55
from system software CD 42–45
system software and ix–x
CD-ROM XA format 2, 62
CD Setup floppy disk, reinstalling
CD-ROM software from 46–49
cleaning CD-ROM discs 7
cleaning the CD-ROM drive lens 6
Clock button (AppleCD Audio Player) 12
close box
in AppleCD Audio Player 15, 19
in CD Remote 26
Close (File menu)
in AppleCD Audio Player 19
in CD Remote 26
closing the AppleCD Audio Player
11, 19
closing the AppleCD Audio Player window 15
closing CD Remote 26
color options, in AppleCD Audio Player 16
Command–Control–Power key, for restarting computer 59
Command–E, for ejecting CD-ROM disc 5, 13
Command–Option key, for creating Photo CD icon 30
Command–Q (Quit)
in AppleCD Audio Player 19
in CD Remote 26
Command–W (Close)
in AppleCD Audio Player 19
in CD Remote 26
communications regulation information vi–vii
compact discs, audio. See audio CDs
Compression Settings dialog box, for copying Slide Show movies 40
Copy (Edit menu), in Slide Show Viewer 39
Copy As (Edit menu), in Slide Show Viewer 39
copying Photo CD images 33, 39
from Slide Show movies into documents 39
customized Play List
in AppleCD Audio Player 17–18
in CD Remote 24–25
customizing CD-ROM software installation
from CD Setup floppy disk 47–49
from system software CD 44–45
Index

D

data files on CD-ROM disc, audio tracks and 57
data specifications 62
data streaming specifications 62
data transfer rates 62
Delete key, as Stop button alternative (AppleCD Audio Player) 13
desktop, At Ease instead of 54
Disc Elapsed Time option 12
Disc Remaining Time option 12
discs. See CD-ROM discs;
floppy disk; hard disk
DOC Class B compliance vii
documents
copying Photo CD images to 39
problems opening 56
Down Arrow key, as Volume control alternative (AppleCD Audio Player) 13
ejecting a CD-ROM disc 5-6.
See also Eject button
elapsed time, displaying
in AppleCD Audio Player 12
in CD Remote 24
electrical safety 7

Enter key, as Play/Pause button alternative (AppleCD Audio Player) 13
environmental specifications 63-64
troubleshooting
See also for CD-ROM disc 56
in programs for opening
Photo CD images 36
Extensions folder, installing QuickTime software in
from floppy disk 52
from system software CD 51
Extensions folder window, checking QuickTime version in 50

F

FCC Class B compliance vi
file formats 2
File menu (AppleCD Audio Player), Close 19
File menu (CD Remote)
Close 26
Get Info 20
Quit 26
File menu, ejecting disc from 5
File menu (Extensions folder), Get Info, for QuickTime software version 50
File menu (Slide Show), Save a Copy 40
File menu (Slide Show Viewer), Preferences 36
file sharing
  ejecting a disc and 5
  over network 8
floppy disk
copying Photo CD images to 33, 39
copying Slide Show movies to 40
reinstalling CD-ROM software from 46-49
reinstalling QuickTime software from 52
Foreign File System
Apple Photo Access in 42
formats requiring 44
“frozen” system 59

G
Get Info (File menu)
in CD Remote 20
for checking QuickTime version 50
graphics, Photo CDs as source of 28

H
hard disk
  copying Photo CD images to 33, 39
  copying Slide Show movies to 40
hardware
  audio 9
  Photo CD 29
    specifications 61, 63–64
headphones, problems with 57
Hierarchical File System (HFS)
  file format 2
High Sierra file format 2
  problems using 56
  reinstalling software for 44–45
humidity specifications 63

I, J, K
index to Photo CDs 32
indicator lights, choosing color for
  (AppleCD Audio Player) 16
inserting a CD-ROM disc 4–5
installation of CD-ROM software,
  checking for 3
ISO 9660 file format 2
  problems using 56
  reinstalling software for 44–45

L
Left Arrow key, as Previous
  track button alternative
  (AppleCD Audio Player) 13
lens, cleaning 6
lights, choosing color for (AppleCD
  Audio Player) 16

M
Macintosh desktop, At Ease
  instead of 54
maintenance 6, 7
marking audio tracks 23
memory requirements, for viewing
  Photo CDs 29
  problems caused by 32, 58, 59
  and resolution, 37
microphone, problems with 58
modes supported 62
multisession Photo CD discs 28
music. See AppleCD Audio Player;
  CD Remote

N
networks, sharing CD-ROM discs on 8
  audio and 8, 57
  ejecting problems 5
Next track button
  in AppleCD Audio Player 12, 13
    keyboard alternative for 13
  in CD Remote 20, 21
“no disc” message, in CD Remote 20
noise specifications 63
Normal mode, in AppleCD
  Audio Player 14
  Track Edit window in 15
O

Open/Close button, on CD-ROM drive 4
troubleshooting 56
opening the AppleCD Audio Player
window 10
opening the CD Remote window 10–11
opening a Photo CD image 33
Options menu (AppleCD Audio Player) 16
order of play, in AppleCD Audio Player 14

P

Paste (Edit menu), in Slide Show Viewer 39
pasting Photo CD images 33, 39
Pause button. See Play/Pause button
“PCD” icons 30
opening Photo CD window with 31
Performa computers
reinstalling CD-ROM software on 49
reinstalling QuickTime software on 50
PHOTO_CD folder 31
Photo CD icons (“PCD” icons) 30
creating 30
opening Photo CD window with 31
Photo CD image icons 32
Photo CD images. See also Photo CDs
copying and renaming 33
copying from Slide Show movies 39
going to 35
problems using 58–59
transferring to another program 37, 38
viewing 30–33
choosing resolution for 32
memory and 29, 32, 58, 59
problems with 58, 59
in sequence 34–35
setting preferences for 35–36
working with in other programs 37–39
Photo CDs 27–40.
See also Photo CD images
adding to ( multisession discs) 28
capacity of 28
compatibility with CD-ROM drive 1, 3
defined 27
ISO 9660 file format and 2
memory requirements for 29, 32, 58, 59
modes supported 28, 62
obtaining 28
reinstalling software for 44–45
software requirements for 3, 29, 42, 50
troubleshooting 58–59
uses for 28–29
viewing icons of 32
Photo CD window 31
photographs, converting to Photo CDs 28
Photos folder 31
choosing resolution in 32
Photos menu (Slide Show Viewer),
for transferring image 38
physical specifications 61–62
Play button. See Play/Pause button
playing modes, in AppleCD Audio Player
Audio Player 14
Track Edit windows for 15
playing music. See AppleCD Audio Player; CD Remote
playing time 62
viewing, in AppleCD Audio Player 18
Play List, creating
in AppleCD Audio Player 17–18
in CD Remote 24–25
Play/Pause button
in AppleCD Audio Player 12
keyboard alternative for 13
in CD Remote 20
checking status of 57
power specifications 63, 64
Preferences (File menu), in Slide Show Viewer 36
image transfer and 38
Previous track button
in AppleCD Audio Player 12, 13
keyboard alternative for 13
in CD Remote 20, 21
printing Photo CD images 33
Program button, in CD Remote 22, 23
Program mode
in AppleCD Audio Player 14
Track Edit window in 15
using 17–18
in CD Remote 23
program requirements.
See software requirements
programs
adding or removing in Slide Show Viewer 36
transferring Photo CD images to 37, 38

radio interference vi
random order, playing audio tracks in
in AppleCD Audio Player 14
in CD Remote 24
read-only memory (ROM) 1
recording from audio CDs, problems 58
reinstalling CD-ROM software x, 41–52
from CD Setup floppy disk 46–49
on Performa computers 49
specific parts of 44–45, 47–49
startup problems after 54–55
from system software CD 42–45
reinstalling QuickTime software
determining need for 50
from CD 51
from floppy disk 52
remaining time, displaying
in AppleCD Audio Player 12
in CD Remote 24
remote control. See CD Remote
renaming an audio track, in
CD Remote 24, 25
renaming a CD-ROM disc 24
renaming a Photo CD image 33
Repeat button
in AppleCD Audio Player 14
in CD Remote 22–23
resolution of Photo CD image
choosing 32
described 37
display problems and 32, 58, 59
memory requirements for 29
restarting the computer 59
Right Arrow key, as Previous track button alternative (AppleCD Audio Player) 13
ROM (read-only memory) 1

Index
safety considerations
   CD-ROM discs 7
   CD-ROM drive vii, 6-7, 55
Save a Copy (File menu, Slide Show) 40
Scan backward/Scan forward buttons
   in AppleCD Audio Player 12, 13
   in CD Remote 20, 21
screen display problems,
   with Photo CDs 58
scrolling through Photo CDs 35
SCSI bus burst rate 62
SCSI ID number, for AppleCD Audio Player 16
selecting a track
   in AppleCD Audio Player 11
   in CD Remote 19
service and support 59
Shuffle button (CD Remote) 22, 24
Shuffle mode (AppleCD Audio Player) 14
   Track Edit window in 15
shutting down computer,
   CD-ROM drive and 6
SimpleText
   image file size and 37
   increasing memory for 29
   opening a Photo CD in 33
Size pop-up menu
   for copying Photo CD images 39
   for transferring Photo CD images 38
Slide Show
   in Photo CD window 31
   playing 34–35
Slide Show icon 34
Slide Show movies
   copying to another disk 40
   copying and pasting
      images from 39
   playing 34–35
Slide Show Viewer
   in Photo CD window 31, 34
   Photos menu, for transferring images 38
   setting preferences in 35–36
   using 34–35
Slide Show Viewer icon 34
   opening 35
software requirements. See also
   CD-ROM software
   CD-ROM file formats and 2
   checking system software version 45
   for high-resolution
      Photo CDs 37
   for Photo CDs 3, 29, 42, 50
   system software ix–x
sound. See AppleCD Audio Player;
   CD Remote
Sound control panel, checking audio source in 57
sound input port 58
Sound option (AppleCD Audio Player) 16
sound output port 57
Space bar, as Play/Pause button
   alternative (AppleCD Audio Player) 13
speakers
   audio channel buttons for 22
   problems with 57
specifications 61–64
starting audio CD software 10–11
StartUp CD Drive (Options menu) 16
startup problems 54–55
Stop button
   in AppleCD Audio Player 12
      keyboard alternative for 13
      in CD Remote 20
support 59
System Folder

Photo CD requirements in 3
reinstalling CD-ROM software in
from a CD 42–45
from a floppy disk 46–49
on Performa computers 49
reinstalling QuickTime software in
from QuickTime floppy disk 52
from system software CD 51
System 7 file-sharing feature,
CD-ROM discs and 8
System 7.1.1, CD-ROM and QuickTime software and ix
System 7.1.2, CD-ROM and QuickTime software and x
system software
checking version of 45, 48
version requirements ix–x
system software CD
reinstalling CD-ROM software from
42–45
reinstalling QuickTime software from 51
starting computer from 54–55

Track Edit window (AppleCD Audio Player) 15
creating a Play List in 17–18
Track Elapsed Time option 12
track icon, playing audio tracks by opening 18, 57
track number display, in
CD Remote 20, 21
Track Remaining Time option 12
tracks. See audio tracks
Tracks pop-up menu (AppleCD Audio Player) 14
Track and time display
in AppleCD Audio Player 12
in CD Remote 20, 21
transfer rates 62
troubleshooting 53–59
audio CDs 57–58
CD-ROM disc icon not on desktop 55
CD-ROM discs 55–56.
See also specific types
CD-ROM drive won't open 55
desktop problem 54
disc ejected by computer 56
disc format problems 56
ejecting a shared CD-ROM disc 5
"frozen" system or "bomb" message 59
headphones 57
High Sierra discs 56
installation and 53
ISO 9660 discs 56
memory problems 58
microphone 58
Photo CDs 36, 58–59
sound input port 58
sound output port 57
speakers 57
startup problems 54–55
warranty considerations 59
U

Up/Down Arrow keys, as Volume control alternative (AppleCD Audio Player) 13

V

View/View As (Photos menu, Slide Show Viewer), for transferring image 38
Volume control
in AppleCD Audio Player 12, 13
keyboard alternative for 13
in CD Remote 20, 21
checking adjustment on 57

W, X, Y

warranty considerations 59
Window Color (Options menu), in AppleCD Audio Player 16

Z

zero display, in CD Remote 20
zoom box, in CD Remote 22
The Apple publishing system

This Apple manual was written, edited, and produced on a desktop publishing system using Apple Macintosh computers and QuarkXPress. Technical illustrations were drawn in Adobe Illustrator; screen shots were created and modified with system software, ExposurePro, Aldus SuperPaint, and Adobe Photoshop. Proof pages were created on Apple LaserWriter printers and on QMS and Tektronix color printers. Final pages were output directly to separated film on a PostScript™-driven imagesetter.

Text type is Times®, display type is Helvetica® Narrow, and cover type is Apple Garamond, Apple’s corporate font. Ornaments are custom symbols designed for Apple Computer. Some elements are set in Apple Courier, a fixed-width font.

PostScript, the LaserWriter page-description language, was developed by Adobe Systems Incorporated.